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Introduction 
 
Welcome to SuperNotecard. 
 
SuperNotecard is modeled around the time-tested technique of using 3 x 5 notecards to organize 
and prepare written compositions. Traditionally writers use notecards to record facts, jot down 
ideas, or sketch out dramatic scenes and then organize them. The organizational process 
includes shuffling the card order, categorizing cards with stickers, and manually creating 
relationships between cards. Some get fancy and use colorful rubberbands, cork boards with 
pins, or cards without the lines. 
 
The intent of this software is to take the traditional approach a few steps further. SuperNotecard 
exports directly to any word processor, offers search tools, an intuitive, visual categorization 
mechanism, character profiling, reference databasing, and makes it easy to flag and notate 
content for later revision. SuperNotecard is part outliner, part word processor, and part content 
manager: everything writers need to bridge the gap between a handful of good ideas and a 
formatted manuscript. 
 
SuperNotecard introduces a variety of elements that you can combine in a way that works best 
for each project. Not all elements or features are relevant to every project. From this perspective 
it will be easiest to assume that there is no right way to use this tool; rather, there are many ways 
to use SuperNotecard and many ways to leverage its capabilities to improve your creative 
process. This document will describe the different elements in SuperNotecard and explain 
broadly how they interact.  
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Getting Started 
 

Mac OS X Installation 
To begin the Mac OS X installation, download the latest version of the product at the following 
URL: http://www.mindola.com. Once the download is complete, double click the file to unpackage 
it. After unpackaging, copy the SuperNotecard application file to your applications folder. Double-
click the green SuperNotecard icon to launch the software. 
 
 

Windows Installation 
On Microsoft Windows computers, SuperNotecard requires Java 1.4.2 or later to run. Before 
attempting to install SuperNotecard, check to ensure that your machine has the appropriate 
version of Java via either of the following steps: 
 

1. Visit Mindola Software's Java test page at http://www.mindola.com/java.html and wait for 
the rectangle on the page to turn green. If the rectangle is not green, your machine is not 
properly configured to run Java applications. As a result the web page will invite you to 
download and install Java 1.4.2. 

2. On your Windows computer press the Start button and select Programs > Accessories > 
Command Prompt. In the screen the follows type the following command (without 
quotation marks) "java -version" and press the Enter key. If your machine has Java 
installed, information about your Java configuration will appear on the screen. Make sure 
that the version listed is greater than 1.4.2. If your machine doesn't have Java, the 
Command Prompt application will report that it does not understand the command.  

 
To get Java 1.4.2, visit Sun Microsystems' download site at 
http://java.sun.com/j2se/1.4.2/download.html 
 
To begin the Windows installation of SuperNotecard, download the latest version of the product at 
the following URL: http://www.mindola.com. Once the download is complete, double click the file 
to initiate the installation. Follow the installation instructions to choose a home for the application 
and optionally launch SuperNotecard. 
 
 

SuperNotecard Activation 
Once the installation is complete, double-click the SuperNotecard icon to launch the product. 
After a moment the following window will appear to request that you either enter the purchased 
activation information and press "Ok" or simply press "Trial" to use the product on a trial basis. 
Throughout the trial you can return to this window and enter activation information by selecting 
"Enter Activation Code" from the application's "Purchase" menu. 
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Starting Projects 
When launching the product for the first time the following dialog will present several choices. 
Check the box entitled "Create New Project" and select from Fiction or Non-Fiction project types. 
Check box entitled "Open Existing Project" to resume work on a previously saved project. To 
explore one of several sample projects, check the box entitled, "Open Sample Project" and select 
a project of interest.  
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Managing Projects 
 
The Project is central to SuperNotecard. SuperNotecard supports two types of projects: Fiction 
and Non-Fiction. SuperNotecard for Scriptwriting supports these and adds screenplay and 
stageplay projects. All projects are composed of individual cards arranged into decks and 
organized by a set of customizable categories. As we will explain later in this document, project 
decks and cards can be linked to other project elements, like References or Factors, and also 
flagged and annotated. 
 
The project types do not differ significantly with respect to these basic building blocks; however, 
they do have a few unique features: fiction projects include a collection of Factors (characters, 
places and things) while non-fiction projects include a collection of References. Because the line 
separating these types of projects is fuzzy, fiction projects can include source information while 
non-fiction projects can include information about persons, places and things. 
 
The following pages will begin to explore in greater detail the variety of elements that come 
together to make SuperNotecard a great writing tool. 
 

·  Project Navigation 
·  Decks 
·  Cards 
·  Factors & References 
·  Categories 
·  Flags 
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Project Navigation 
SuperNotecard includes several mechanisms to help writers work with projects and the areas 
within them. 
 

Project Tabs 
Open projects are listed as tabs along the bottom of the application. Each tab includes the project 
title and, if the project has been saved, the project file name. An icon resembling a miniature 
floppy disk will appear next to the project title if the project has changed since started or last 
saved. 
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Project Navigation Bar 
By default large icon buttons are aligned vertically along the left of the application window to 
provide quick access to the main areas of each Project, including Factors for fiction projects or 
References for non-fiction projects, Categories, Flags, Trash and the Project Explorer. Note that 
the Project button image will change depending on the type of project. Fiction projects have a 
green book icon and non-fiction a brown book icon. 
 
The Project Navigation Bar can be set to show along either the left or right side of the application 
window or hidden entirely via the application Preferences. For a quicker way to show and hide the 
Project Navigation Bar, type Ctrl (Win) or Cmd (Mac) and "T". 
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Project Deck and Card Navigation 
The main components of any project are the decks of cards. Press the Project button at the top of 
the Navigation Bar to display the deck and card contents of your project. 
 
In the deck or card toolbar there are a series of buttons aligned across the top, beginning with the 
home button and ending with a button representing the current selected deck or card. 
Intermediate buttons represent the hierarchy of decks situated between "home" and the current 
selected deck or card. Press any of these to jump to the item named by the button. 
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When viewing the contents of the project from the starting point (or "home") or when viewing the 
contents of a particular deck, double-click a card to display and edit its details. Double-click any 
deck to drill down into the contents of the deck. 
 

  
 �	!� %
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Decks appear in the Deck Display with a number in the lower right representing the number of 
elements that it contains. Compared to Cards, Decks have a shadow effect to appear taller. The 
Decks' appearance can be further customized by coloring them or by turning on the option in the 
Deck Display Options to show a binder-clip image. 
 

Project Explorer & Search 
SuperNotecard includes a Project Explorer for quick access to every aspect of the project and a 
Search tool for conducting keyword searches. Select "Project Explorer" from the application's 
View menu to open the Project Explorer. Select "Project Search" from the application's View 
menu to display the Project Search tool. 
 
In the Project Explorer, or hierarchical representation of the project, click the triangles next to the 
icons to reveal the contents. Clicking any element in this arrangement will display details. Using a 
click-and-drag method, elements can be moved to new locations in the hierarchy. When moving a 
card on top of a deck, the card is moved to reside within the highlighted deck. When moving a 
card on top of another card, the card is moved to reside next to and following the highlighted 
card. Press and hold the Ctrl (Win) or Option (Mac) key to duplicate the selected element. To 
reveal additional features with respect to elements in the Project Explorer, click any element 
using the right mouse button. 
 
Find specific project elements by entering keywords in the field located at the top and pressing 
"Enter". Search results appear in a list beneath the entry field. Select any one of the results to 
display its detail. The following conventions apply to the keyword search: 
 

·  Separate multiple keywords with commas to fetch matching elements that possess ANY 
of the entered words 

·  Separate multiple keywords with spaces to fetch matching elements that possess ALL of 
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the entered words 
·  Keywords enclosed in double quotation marks fetch matching elements that possess all 

of the words and spaces between the marks 
·  Search results appear in the order that the elements appear within the project. Click any 

entry to display its details. 
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Decks 
 
Much like real, three-by-five index cards, the cards in SuperNotecard are arranged in decks. 
Every deck includes a title and a description. Decks can be categorized, color-coded, and 
flagged. They can naturally include cards but also other decks. A card in the Deck Display 
resembles a single card while a deck resembles a stack of cards. 
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Moving Around in the Deck Display 
Use your mouse or the keyboard arrow keys to select elements in the Deck Display. Hold the Ctrl 
(Win) or Cmd (Mac) key when clicking on elements to select more than one. Hold the Shift key to 
select multiple contiguous elements. 
 
Select and reposition an individual element on the screen with the mouse to reorganize the 
contents of a deck. With an element selected, hold the mouse button down and drag it to a new 
location. Choose a location between elements or choose another element: choose another card 
to move the selected element after the card, or choose another deck to move the selected 
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element into the deck. 
 
Select "Cut" from the application's Edit menu to remove selected elements and place them on the 
application's clipboard. To restore the cut elements, first choose a target location by either 
selecting the space between elements or selecting an individual element. Selecting "Paste" from 
the application's Edit menu will restore the elements to the target location. If the target location is 
another element, the restored elements will appear directly following the element. 
 
Select "Copy" from the application's Edit menu to copy selected elements and place them on the 
application's clipboard. To paste the copied elements, first choose a target location by either 
selecting the space between elements or selecting an individual element. Selecting "Paste" from 
the application's Edit menu will insert the elements to the target location. If the target location is 
another element, the new elements will appear directly following the element. 
 
Select "Move to Trash" from the application's Edit menu to remove selected elements and place 
them in the project's trash bin. To undo the removal select "Undo Move to Trash" from the 
application's Edit menu. 
 
Select "Delete" from the application's Edit menu to delete the selected elements permanently 
from the project. To undo the deletion select "Undo Delete" from the application's Edit menu. 
 
Please refer to the Common Keyboard Shortcuts to learn how to move one or more elements 
forward or backward in the sequence of the deck. Shortcuts are also available to promote or 
demote elements in the hierarchy. 
 

Deck Display Layouts 
The Deck Display can be oriented using two layouts. The default layout is the wrapping layout. 
With this layout elements are distributed across the screen in as many columns as the width of 
the application allows without requiring a horizontal scrollbar. The number of rows will depend on 
the number of elements in each deck and the number of columns permitted by the width.  
 
The alternative layout is the Grid layout. In the grid layout there are two possible orientations: 
Column and Row. An important new option in the grid layout relates to the gaps between 
elements. The default behavior automatically removes gaps; like stacking blocks, elements can 
be situated anywhere on the grid and will automatically "adhere" to either the left axis in the Row 
Orientation or top axis in the Column Orientation. If gaps are not automatically removed, then 
writers can position items anywhere on the grid and they will stay. 
 
In the Column Orientation, alphabetic labels sit across the top to identify each column. In the Row 
Orientation the labels span down along the left to mark rows. The allowable number of columns 
and rows is controlled via the Deck Display Options. 
 
The layouts and orientations can be switched as desired. When making changes to the deck 
organization with Wrapping Layout, SuperNotecard works behind the scenes and estimates how 
you'd expect to see the new organization applied to the Grid Layout with either the Row or 
Column Orientation so that you can switch among them with ease. Note that when you elect to 
have the program automatically remove gaps in the Grid Layout, any gaps are permanently 
removed. 
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Element Sequence per Layout 
The sequence of elements in the Grid Layout with Row and Column Orientations is not obvious 
when compared to the “left to right” sequence of the Wrapping Layout. With the Row Orientation, 
elements are sequenced starting with each row, tracking from left to right and then moving down 
to the next row. With Column Orientation, elements are sequenced starting with the first column, 
tracking down and then moving right to the next column. 
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Editing Elements from within the Deck Display 
To load and begin to refine the content of any element in the Deck Display, double-click (or press 
the primary mouse button twice) any individual card or deck. 
 
To quickly edit an element without leaving the deck display, select a deck or card and press any 
key on the keyboard. The title and description for the selected element immediately appear in an 
editing window. Change the content as desired. Press the "Esc" key to cancel the editing. Press 
the Ctrl (Win) or Cmd (Mac) and "Enter" key or click elsewhere on the screen to commit to the 
changes and hide the editing box. 
 

Assigning Decks to Categories 
Decks can belong to one or more Categories. From the Deck Display, elements within a deck can 
also be categorized. To begin to manage a deck's category assignments, press the category 
button (  ) in the toolbar. Select from the following options to the conduct the appropriate 
assignment: 
 

·  Select "Assign (deck title) To" and then choose a category or the option to create a new 
one to assign the current or visible deck to a category 

·  Select "Assign All To" and then choose a category or the option to create a new one to 
assign the all of the deck's elements (and their respective subordinate elements) to a 
category 

·  If elements are selected in the Deck Display, select "Assign Selected Items To" and then 
choose a category or the option to create a new one to assign the selected items to a 
category. 

 
Select from the following options to conduct the appropriate removal: 

·  Select "Remove (deck title) From" and then choose a category to remove the current or 
visible deck from a category 

·  Select "Remove All From" and then choose a category or the option to create a new one 
to assign the all of the deck's elements (and their respective subordinate elements) to a 
category 

·  If elements are selected in the Deck Display, select "Assign Selected Items To" and then 
choose a category or the option to create a new one to assign the selected items to a 
category. 

 
 
Categories appear as colored squares adjacent to the deck's title field. Double-click any square to 
edit the category; hover the mouse over a specific square to display the category name. 
 
For Deck Display contents categories appear as small, colored rectangular tabs along the top and 
right of each categorized element. Hold your mouse above the colored rectangle to view the 
category name. 
 
To control the sequence of the assigned categories, use your mouse to click and drag the 
category rectangle to a new a new spot in the sequence. You may also remove a category by 
click-dragging it away from the deck. 
 

Highlighting a Specific Category 
Since a deck or card may be assigned to more than one category, it is beneficial to see only one 
category at a time in the Deck Display. To filter by a specific category select "Highlight 
Category..." from the application's View menu and choose the desired category. To turn off the 
filtering and show all category assignments, select "None." 
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Flagging a Deck 
Decks with content that requires follow-up or that represents a crucial point in the writing process 
can be flagged. To flag a deck from within the Deck Display, press the flag button ( ) from the 
toolbar. Pressing the flag button displays an area into which writers can record notes relating to 
the deck. De-press the toolbar's flag button to hide the flag notes. With the flag notes visible and 
the flag toolbar button pressed, use the buttons in the orange-colored, right margin to manage the 
flag: 
 

·  Press the clock button to add the date and time to the flag notes. 
·  Press one of the four red, yellow, blue or white buttons, to color code the flag. 
·  Press the 'x' button to hide the flag. 
·  Press the trash bucket to eliminate the flag.  

 
 
To flag a deck or card within another deck, highlight it and select "Flag Card/Deck" from the Edit 
menu. Enter details in the dialog that follows. Press the "Ok" button to save the flag. 
 
In the Deck Display, a flagged element has a small, red, blue or yellow triangle cutting through 
the upper right corner. 
 
All flagged items are listed in the Flags area of the project. View a project's flagged items by 
pressing the large "Flags" button on the Project Navigation Bar. Double-click individual flagged 
items in the list to see the item details and review the flag notes. 
 

Deck Toolbar & Options 
The Deck Display includes a toolbar at the bottom of the screen with a series of buttons for easy 
access to most used features. 
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Size 
Increase or decrease the size of the miniature decks and cards using the plus or minus buttons. 
 
Layout 
Select wrapping layout, column layout or row layout. 
 
Optimize 
Select to maximize your Deck Display space and hide the title and description areas. 
 
Flatten (Hide Project Hierarchy) 
When displaying decks using the spread layout, users have the option to hide the entire project 
hierarchy. In this mode all decks are hidden throughout the project so that all cards are shown in 
one spread. To flatten or hide the project hierarchy in the spread layout, press the Flatten button 
(graphic) along the bottom of the deck display. SuperNotecard uses card coloring to suggest the 
hierarchy normally represented by the decks. The Project Explorer will also automatically expand 
to reveal the complete array of cards. Card coloring is also used in the Project Explorer. 
 
Numbering 
Press the Numbering button to show the element numbers in the right margin. 
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Key 
As the number of elements in your deck grows and the variety of colored markers increases, the 
deck display can become cluttered. To help distinguish Categories and Factors or References in 
the Deck Display, use the Deck Display Key.  Press the Show Key button or type Ctrl (Win) or 
Cmd (Mac) and "K" to display a panel with two sections. The top section includes Factors or 
References and their colors in your project. The drop-down menu allows you to choose a folder to 
limit the number of listed references or factors. The lower section lists all Categories and their 
corresponding colors. Click and drag Factors or References from the key to Cards in the Deck 
Display to create links. Assign elements in the Deck Display to Categories using the same 
approach. 
 
Metrics 
Press the Metrics button to display a bar chart depicting one of several deck measurements. 
Depending on the type of project, pick to display how much text, amount of dialogue, number of 
references or factors,  tension level, or number of cards. Pass over any bar with the mouse to 
view the title of the element represented by the bar; click any bar with the mouse to load the 
represented element.  
 
Options 
Press the Options button to edit Deck Display options, including Content Options, Sizing Options 
and general Application Display Options.  
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Cards 
�
In SuperNotecard the basic building block of every project is a card. A card is logically 
synonymous with a paragraph. It can also represent a fact or capture a scene, etc. Each card has 
a title or summary statement and content; it can belong to one or more categories, and can have 
a flag with notes. Cards can also have relationships to other project elements like References or 
Factors and their respective details. 
  

Assigning Cards to Categories 
Cards can belong to one or more Categories. Press the category button (  ) in the toolbar to 
manage the card's category assignments. From the menu select "Assign (card title) To" and then 
choose a category or the option to create a new one. To remove an existing category 
assignment, select "Remove (card title) From" and then the desired category. 
 
Categories appear as colored squares adjacent to the card's title field. Double-click any square to 
edit the category and hover the mouse over a specific square to display category name. 
 

Flagging Cards 
Cards that require follow-up or represent a unique point in the writing process can be flagged. To 
flag a card from within the card display, press the flag button (  ) from the toolbar. Pressing the 
flag button displays an area into which writers can record notes relating to the card. De-press the 
toolbar's flag button to hide the flag notes. With the flag notes visible and the flag toolbar button 
pressed, use the buttons in the right margin to manage the flag: 
 

·  Press the clock button to add the date and time to the flag notes. 
·  Press one of the three red, yellow or blue buttons, to color code the flag. 
·  Press the 'x' button to hide the flag. 
·  Press the trash bucket to eliminate the flag.  

 
 
To flag a card from within a deck display, highlight a card and select "Flag Card" from the Edit 
menu. Enter details in the dialog that follows. Press the "Ok" button to save the flag. 
 
All flagged items are listed in the Flags area of the project. View a project's flagged items by 
pressing the large "Flags" button on the Project Navigation Bar. Double-click individual flagged 
items in the list to see the item details and review the flag notes. 

Relating Factors and References to Cards 
Often it is beneficial to create relationships between Cards and the Factors that participate in 
them or the References that provide the foundation for the content. These relationships provide a 
convenient mechanism for visualizing and refining your project. 
 
If an individual Factor or Reference title or keywords exist in the content of the card, 
SuperNotecard will discover them when you press the comb button (  ) or keystroke, Ctrl-K 
(Win) or Cmd-K (Mac). Once discovered, they appear temporarily in the table at the bottom of the 
card in gray. Permanently attach each item to the card by pressing the pin button (  ). Once 
attached, they will always appear in the table at the bottom of the card.  
 
Factors and References can be directly attached to the card by pressing the add button (  ) 
and choosing the desired item. New Factors and References can be created and then added by 
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selecting "Add New Factor...". Use the following buttons to manage the related items: 
 

 Find new references 

 Show as Text 

 Add item 

 Edit selected item 

 Move selected item up in the table 

 Move selected item down in the table 

 Delete selected item 
 
To further define a Factor or Reference's relationship to the card, select an item from the table 
and again press the add button to attach characteristics or reference details--like page numbers--
that pertain to this card. Finally all of these relationships can be described with notes. Press the 
add note button (  ) next to any item in the table to record notes. SuperNotecard includes a 
separate mode that allows writers to edit notes as text rather than as rows in a table. Press the 
"Show as Text" button (  ) to switch to text mode. Conversely press the "Show as Table" button 
(  ) to return to the tabular view of the related elements. 
 
Cards will automatically check the text for words that resemble the related Factors and 
References. Matches are highlighted. To insert a Reference or Factor select Insert from the Tools 
menu or right-click (Win) or ctrl-click (Mac) to show a popup menu with an Insert option. 
 
You can define keywords for each Reference or Factor to more precisely control how they are 
discovered by the comb button. For example, you could define a keyword like NYT_NOV_11 for a 
New York Times article published on the 11th of November and then include this keyword when 
working a quotation into a paragraph (on the card). When you press to comb the card for 
references, this article will appear as a candidate at the bottom of the card. As indicated, press 
the pin button to permanently attach the reference to the card. Keywords are created and 
maintained in the Reference or Factor’s detail screen. 
 

Defining the Tension in Cards 
The tension property allows you to mark or grade individual cards with a number. It is called 
tension, but should be understood to also represent intensity or emphasis. A higher number will 
raise the level on the thermometer icon and indicate more tension, intensity or emphasis. To 
manage the card's tension level, press the tension button (  ) in the toolbar. From the menu 
select from numbers between 1 or low tension and 10 or high tension. To remove the 
assignment, select "None". Tension appears immediately next to the card's title field. You can 
graph the tension across the elements in a particular deck by selecting to show metrics from the 
Deck Display toolbar. 
 

Card Keyword Search 
To help locate specific words and phrases in the card that you’re working on select the 
magnifying glass icon along the right margin. Enter a word or phrase to find and press enter to 
see the text highlighted in the body of the card. To locate other instances of the word or phrase 
repeat the above steps or type the “F8” key. Press “F8” again to continue through the card 
content and view other matches. For efficiency the “F8” key automatically clicks the “Ok” button in 
the Keyword Search dialog. 
 

Text Styles 
SuperNotecard also has a highlighter that functions like a real highlighting pen. Highlight specific 
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words and phrases in the Card view by using the keystroke Ctrl+J (Win) or Cmd+J (Mac) or right- 
clicking (Win) or ctrl-clicking (Mac) selected text and choose Highlight from the popup menu. To 
remove highlighting, click anywhere within the highlighted text and again right-click (Win) or ctrl- 
click (Mac) to select Remove Highlight from the popup menu. Settings in the Application 
Preferences let you control the default color of the highlighting. 
 
Text can also be emphasized by applying bold or italic style. Select the words to make bold and 
press Ctrl+B (Win) or Cmd+B (Mac). Press Ctrl+I (Win) or Cmd+I (Mac) for italics.  
 
Control any of the above via the buttons along the upper right of margin of the card. Note that 
these buttons are hidden when the flag notes are shown. 
 
As of the most recent version, you can define and apply custom fonts and sizes to content in 
Cards within Fiction and Non-fiction projects. Select the icon that resembles a carpenter’s square 
along the right margin to manage styles.  
 

Script Formatting (Scriptwriting only) 
Screenplay and Stageplay projects each have distinct script formatting capabilities. The primary 
format types include action, character, parenthetical, dialogue, and transition. All can be applied 
using the format tool (  ) located along the right margin of the card, or using the tab key while 
entering the text for your script. To accelerate and simplify the formatting of your script the 
program will automatically apply appropriate formats to the text when you press the tab key 
depending on the placement of the cursor. 
 
Ex. Screenplay 
With screenplay projects, when you begin by typing the action for your scene, press Enter to 
move to the next line and press tab to move the cursor to the correct location for entering the 
name of a character.  
 
Next, after the character is typed and you press Enter to move to the next line, SuperNotecard for 
Scriptwriting automatically assumes you intend to type dialogue. Press the tab key while holding 
down shift to back up and enter a parenthetical phrase. Pressing Enter again automatically 
positions the cursor correctly to enter dialogue. 
 
Transitions can be applied by pressing the tab key twice at the beginning of a new line. 
 

Smart Keystroke (Scriptwriting only) 
To expedite the entry of repeated text or character names in your scene, press Ctrl+L (Win) or 
Cmd+L (Mac) to display a list of common phrases. When the cursor is in position to add a 
transition, use the smart keystroke to show and select from a list of common script transitions. 
Tab in to begin to enter a character name for dialogue and use the keystroke to quickly grab from 
the list of available characters. The smart keystroke is also prepared to help when punching in the 
scene title or slug line. Use it at the beginning of the title to select interior or exterior; at the end 
select common descriptive phrases. 
 

Automatic Spell Check 
Cards automatically check for spelling errors and highlight suspicious words. Settings in the 
application Preferences let you choose the text color for spelling mistakes, whether to 
automatically check for mistakes and which language word list to reference. SuperNotecard 
includes English (both British and American) and French word lists. Other word lists can be 
referenced via the application Preferences. Custom words can also be added there. 
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Card Statistics 
Every card displays important information along the bottom, including: number out of the total 
number of cards in the project and deck, the character and word count, and the date indicating 
when the card was last changed. To update the word and character counts, press the refresh 
button (  ) located next to the counts. 
 

Scene Timer (Scriptwriting only) 
Tally the duration of each card or scene with the Scene Timer. To start the timer, press the green 
start button (  ) and press the stop button (  ) to stop the time. Press the pencil icon (  ) 
within the time window to specifically enter the minutes and seconds. The Deck Display will 
compute and display the total time for the deck as well as show the individual times for each 
element. Visit the application Preferences to determine whether to include Scene Times when 
printing and exporting projects. 
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Factors & References 
 
SuperNotecard enables writers to collect and organize information about elements that relate to 
the primary content of their work. In SuperNotecard fiction projects these elements are called 
Factors and include things that "factor" into the composition, like persons, places, and things. For 
non-fiction projects these elements are called References and include sources like books, 
magazines, encyclopedias and websites. All types of Factors or References can be included in 
any type of project. For example, a place such as Hibbing, can be created and used in a non-
fiction biography project about Bob Dylan. Likewise, many traditional sources would be important 
to a fiction project about the Vietnam War. 
 

·  Factors & References List 
·  Factor & Reference Editing 
·  Factor Types 
·  Reference Types 
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Factors & References List 
 
To begin to define Factors or References in the project, select the References or Factors button 
from the Project Navigation Bar. The icon and label for the button differ depending on the type of 
project.  
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Adding & Editing 
Create a new Reference or Factor by pressing the "Add" button (  ) on the toolbar. Enter the 
name and description, specify the type, and select the color from the drop-down in the screen that 
follows. To edit the selected Factor or Reference, press the "Edit" button (  ). 
 

Organizing 
References and Factors can be combined into one or more folders to organize them. Create a 
new folder by pressing the "Add" button (  ) on the toolbar to the right of the Folders list. To edit 
the selected folder, press the "Edit" button (  ). Folders can be ordered via the up and down 
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arrows. Select a folder to view its contents. 
 
To move a factor or reference to a particular folder, select the item using the mouse and drag it to 
the desired folder. When viewing the contents of a particular folder, you can remove a folder item 
by selecting it and pressing the trash can. 
 

Factor and Reference Order 
Factors and References can be ordered by pressing the "Sort" button (  ) on the toolbar. On 
the dialog that follows, select to sort by name or type. Use the arrow buttons to move individual 
items up or down in the table. Press "Ok" to apply the organization to the project. Note that the 
created order will be used even when organizing items into different folders. 
 

 
�
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Popups 
For convenience an individual Factor or Reference can be edited in a separate window. To edit a 
Reference in a separate window, select a Factor or Reference from the list press the "New 
Window" button (  ) on the toolbar. 
 

Relating Factors & References to Cards 
Cards appear in a table at the bottom of the screen if they have a relationship to the selected 
Factor or Reference. 
 
Notes 
Double-click the notes icon (  ) in the column next to a particular card to record more detail 
about the relationship between the card and the Factor or Reference.  
 
Finding Relationships 
Additional cards can be related in bulk to the selected Factor or Reference by pressing the "Add 
Related Cards" button (  ) adjacent to the table. The dialog that follows will show a list of cards 
that include references to the Factor or Reference title or keywords but have not been related. 
Press the pin button (  ) to create a relationship between the card and the Factor or Reference 
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in question. Press the detach button (  ) to break the relationship. Select any card from the list 
to view its content and, more specifically, to view the text that references the title or keywords. 
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Factor & Reference Editing 
�
To begin a catalogue of references or a collection of persons, places or things in the project 
select "View Factors" or "View References" from the application's View menu. Press the "Add" 
button (  ) on the toolbar to start a new Factor or Reference. Edit the new element via the 
following screen: 
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Choosing the Type 
Once the title has been assigned to the new Factor or Reference, choose the type from the 
adjacent drop-down list. In fiction projects the Factor types appear first, followed by the Reference 
types. In non-fiction projects, References types appear at the top followed by the Factor types. 
 

Color Coding 
Select a color from the drop-down list for the each Factor or Reference to help to identify it 
throughout the project. When a new Factor or Reference is created a unique color is 
automatically selected by the application. Select a new color from the drop-down to customize the 
Factor or Reference. The color coding will appear in the background of the Factor or Reference 
icon in the Project Explorer and elsewhere in the project. The color will also be used for the tags 
along the left of each related card in the Deck Display. 
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Defining Reference Details or Factor Characteristics 
Both References and Factors can be further defined with the help of Details and Characteristics. 
Details or Characteristics are arranged in the table beneath the description. Use the following 
buttons to add, edit or delete a selected item. Selected items can be moved up or down using 
either of the arrows. There is no limit to the number or variety of details that can be created. 
 

 Add item 

 Edit selected item 

 Move selected item up in the table 

 Move selected item down in the table 

 Delete selected item 
 
For each Reference Type, a collection of standard details are highlighted with the reference 
type's icon. Select "Add All Relevant Details" from the pop-up menu to add all appropriate details 
for the selected reference type. For example, selecting "Add All..." for a book reference will add 
Author, Title, Publication City, Publisher, and Publication Date to the table. Double click each item 
to enter the specifics. 
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To simplify this process, SuperNotecard has introduced a separate mode for modifying details 
and characteristics that allows writers to edit them as text rather than as rows in a table. Press 
the "Show as Text" button (  ) to switch to text mode. Conversely press the "Show as Table" 
button (  ) to return to the tabular view of the reference details. 
 

Managing Related Cards 
Cards that have a relationship to the Factor or Reference appear in a table at the bottom of the 
screen under the "Related Cards" tab. Select a specific Factor Characteristic or Reference Detail 
to show only those cards with an additional relationship to the selected item. Deselect the 
character or detail to return to showing all cards that relate to the Factor or Reference. 
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Notes 
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Double-click the notes icon (  ) in the column next to a particular card to record more detail 
about the relationship between the card and the Factor or Reference.  
 
Finding Relationships 
Additional cards can be related in bulk to the selected Factor or Reference by pressing the "Add 
Related Cards" button (  ) adjacent to the table that lists related cards. The dialog that follows 
will show a list of cards that include references to the Factor or Reference title or keywords but 
have not been related or linked. Press the pin button (  ) to create a relationship between the 
card and the Factor or Reference in question. Press the detach button (  ) to break the 
relationship. Select any card from the list to view its content and specifically the text that 
references the title or keywords. 
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Factor & Reference Keywords 
An important part of SuperNotecard's usefulness as a composition tool is its ability to connect 
content to other elements that support it, like characters, facts, and sources. SuperNotecard 
helps writers connect Factors or References to cards by looking in the text of cards for either the 
use of the Factor or Reference title or the use of any defined keywords. By default the Factor or 
Reference title is used in the search of the card text. Each Factor or Reference can optionally 
define keywords to be used instead of the entire element title. This makes it easy to use a 
character's full name as the title for a Factor and define more relevant keywords to use for 
relationship searching. For example, a Factor can be introduced with a title like "Humbert 
Humbert" and a set of keywords including, "Humbert", "H.H.", "Humberg", "Humbug", and 
"Herbert".  Now a scan of the composition will uncover all cards with references to any of these 
keywords. 
 
Press the "Keywords" tab at the bottom of the screen to define keywords for the Factor or 
Reference that is being edited. Add and remove a keyword phrase or edit the selected keyword 
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phrase using the buttons along the right toolbar. Use these guidelines when entering keywords: 
 

·  Keywords are case-sensitive 
·  Enter keywords on separate lines to find Cards that relate to any of the words. 
·  Enter keywords on the same line to find Cards that relate to them as a group. 
·  Leave the area blank to defer to the Factor title (Humbert Humbert) as the search 

keywords. 
·  Press "Add Defaults" to quickly introduce a set of pertinent keywords 
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Factor & Reference Folders 
Factors and References can be organized into folders. Select the "Folders" tab to view folders 
that the item belongs to. Add and remove a folder or edit the title of the selected folder using the 
buttons along the right toolbar. 
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Factor Types 
The following types can be used to help define project factors: 
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 Person 

 Person (minor) 

 Place 

 Thing 

 Event 

 Other 
 

Factor Characteristic Types 
The following types of characteristics can be associated with project factors: 
 

 Arc 

 Back Story 

 Biography 

 Fear 

 Goal 

 Mood 

 Trait 

 Other 
 

Reference Types 
The following types can be used to help define project references: 
 

 Book 

 Book Chapter 

 Encyclopedia 

 Journal 

 Magazine 

 Newspaper 

 Website 

 Other 
 
 

Reference Detail Types 
Every Reference can have a set of details. Reference details fall into one of several categories: 
 

 Associated Institution 

 Author 

 Compiler 

 Edition 

 Editor 
 File Shortcut 

 Name 

 Page Numbers 

 Publisher 

 Publication City 

 Publication Date 

 Section 

 Title 

 Title of Article 
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 Title of Chapter 

 Title of Periodical 

 Title of Website 

 Translator 

 URL 

 URL Access Date 

 Volume 

 Other Detail(s) 
 



SuperNotecard Help Documentation 36 

Categories 
 
Categories help to boldly determine what type of deck or card you’re working with. For instance, 
define a “Fact” category and assign it to a card to indicate that it is a factual card; likewise define 
an “Opinion” category to denote an opinion card. Categories in SuperNotecard complete the 
phrase, “this card is a _____”. In contrast References complete the phrase, “this card has 
a_____”. For example, writers can indicate that a card has a reference to the Encyclopedia 
source with a Reference element and indicate that a card is a fact with a Category. 
 
To use Categories in your project, begin by selecting the categories button from the Project 
Navigation Bar. Current categories are listed in the upper left box. Select a category from the list 
to display both the category description and decks and cards in the project that are assigned to 
the category. Select the item labeled, "Unassigned", to view decks and cards that have not been 
assigned to any particular category. Both decks and cards can be assigned to more than one 
category. 
 

 
 
 

Adding & Editing Categories 
To add a new category, press the "Add" button (  ) from the toolbar. In the dialog that follows 
specify the name for the category and optionally enter a description and change the color. 
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To edit an existing category, double-click the category or select the category and press the "Edit" 
button (  ) from the toolbar. Category descriptions can be revised by selecting the category in 
the list and entering or changing the text that appears to right of the category list. For 
convenience individual Categories can be worked on in separate windows. To edit a Category in 
a separate window, select a particular category and press the "Edit in a New Window" button (  
) on the toolbar. 
 
 

Reorganizing 
Categories can be reorganized by pressing the "Sort" button (  ) on the toolbar. On the dialog 
that follows, select to sort by name or type. Use the arrow buttons to move individual items up or 
down in the table. Press "Ok" to apply the organization to the project. 
 

 
%
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Popups 
For convenience an individual Category can be edited in a separate window and left open while 
you work with other aspects of the project. When you save the project, the positioning of the 
window will be preserved. To edit a Category in a separate window, select one from the list and 
press the "New Window" button (  ) on the toolbar. 
 

Revealing Related Decks & Cards 
With each selected category a listing of all decks and cards assigned to that category appear in 
box along the bottom. The elements are listed in the order that they appear in the project. Double- 
click any element to view its details and modify its contents. Decks and cards can be assigned to 
any category using the following techniques: 
 

·  Click and drag a card or deck to a category in the upper left box to assign it to just that 
category. Hold down the "Ctrl" key (Win) or "option" key (Mac) to assign the card to the 
category while keeping the current card category assignments. 

·  Right-click (Win) or ctrl-click (Mac) the card to introduce a popup with several assignment 
choices.  
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Assigning Decks & Cards to Categories 
Assigning Decks & Cards to Categories can be done throughout the application: 
 

·  From the Deck Display, assign elements to a category by selecting them and choosing 
"Assign To Category..." from the application's Edit menu. Additionally display the Key and 
click-drag categories to elements. 

·  From the Project Explorer, right-click (Win) or ctrl-click (Mac) the selected card and 
choose from the popup to categorize. The Project Explorer also allows writers to click- 
drag a card onto the desired Category to categorize it. Hold down the "Ctrl" key (Win) or 
"option" key (Mac) to add the card to more than one category.  For convenience, the 
reverse (drag Category to card or deck) is also permitted.  

 

Using Categories to Manage a Time Line 
It may be important to group different elements by "points in time" and conveniently see the 
elements on a time line. In fiction for example, the sequence of the content (i.e., the cards) may 
follow the perspective of specific characters so that in chapter one we see the story from John's 
perspective and then in chapter two from Sally's. To see cards for both John and Sally that 
represent some point in time, like the first day of school or Monday's lunch, SuperNotecard uses 
a special type of category called a Point in Time Category. 
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Point in Time categories can be assigned to cards and decks just like basic categories. They can 
be viewed separately on a time line by selecting the "Timeline" tab to the left when viewing 
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Categories. The point in time categories can be sorted in ascending or descending order and 
display related cards and decks in the order that they appear in the project. 
 
To specify that a category should represent a Point in Time select a basic category and press the 
"Edit" button (  ) from the toolbar and select the box next to "This Category represents a point 
in time". Next choose a date and specify a time. While the dialog expects values for both data 
and time, neither are required. If you are working on a research project and need to organize 
events, like laboratory results for example, that take place within one hour, simply select any date 
and choose times that are within some hour of the day. If, for example, you are writing a historical 
novel and need to organize content treating some events that took place in the springtime of 1912 
and other events that took place in the winter of 1908, choose dates that approximate the 
seasons and specify a time if relevant. 
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Other Common Uses for Categories 
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Flags 
�
Decks and cards in the project that have been flagged are listed in the Flags area of the project. 
Select "Flagged Items" from the application's View menu to display list of flagged items. 
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Flagged items are listed in the order that have in the sequence of the project. The first column in 
the table includes each item's location. The second includes the contents of the flag notes, and 
the third displays the text or description of the Deck or Card. 
 
Select an item and press "Edit Flag" (  ) from the toolbar to edit the flag notes. Press "Delete 
Flag" (  ) from the toolbar to permanently delete the flag from the selected item. Double-click a 
selected Deck or Card to display and edit its contents. 
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Exporting & Printing Projects 
 

Exporting to RTF 
Projects can be exported to an *.rtf file (Rich Text Format) by selecting "Project..." from the 
"Export" entry under the File menu. The export process captures every element in the project, 
preserves the sequence, and builds a single file. Rich text files are compatible with most word 
processing programs. Changes made to an exported *.rtf file, cannot be re-imported into a 
SuperNotecard project. 
 

Exporting to RTF for Final DraftTM (Scriptwriting Only) 
Projects can be exported to an *.rtf file (Rich Text Format) with a special format to correctly import 
into Final Draft and preserve the script character, dialogue, action, transition, and title formatting. 
Select "Project to RTF for Final Draft..." from the "Export" entry under the File menu. The export 
process skips decks, preserves the sequence of the cards, and builds a single file that won't 
include Factors, References, Categories, and Flagged or Trashed items. 
 
Note that changes made to an exported *.rtf file, cannot be re-imported into a SuperNotecard for 
Scriptwriting project. 
 

Exporting Project Outlines 
Projects can also be exported in an outline format to an RTF file (Rich Text Format). By default 
SuperNotecard's exported outline includes all element titles and excludes all element 
descriptions. To export the project as an outline, select "Project Outline..." from the "Export" entry 
under the File menu. Changes made to an exported outline *.rtf file, cannot be re-imported into a 
SuperNotecard project. 
 
 

Exporting & Importing OPML 
SuperNotecard supports a new outline file format called "Outline Processor Markup Language" or 
OPML. SuperNotecard's OPML export includes only deck and card titles and descriptions and 
excludes all other elements. To export the project as an OPML outline, select "Project to 
OPML..." from the "Export" entry under the File menu. 
 
Unlike the RTF outline export, SuperNotecard can import OPML files. SuperNotecard will 
translate all OPML file elements into Deck and Card titles and descriptions. 
 
 

Exporting & Importing Text 
SuperNotecard is also equipped to export and import the project as text. When either exporting to 
or importing from a text file, SuperNotecard prompts you to specify both the element separator as 
well as the content separator. The element separator differentiates between individual decks and 
cards while the content separator differentiates the title from the description. When exporting the 
project to text, SuperNotecard ignores the hierarchical relationship between decks and cards and 
does not include project references or factors, categories, flagged items and trashed items. When 
importing text into a SuperNotecard project, each element in the text simply becomes a card. 
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Project & Outline Printing 
Writers can print projects by selecting "Project..." from the "Print" entry under the application's File 
menu. Printed projects follow the order and sequence of the various elements. SuperNotecard 
also enables project outline printing. To print the project outline, select "Outline..." from the "Print" 
entry under the File menu. 
 
In addition to printing the entire project or the project outline, portions of the project can be printed 
via the Print entry under the File menu: 

·  Items in the selected Category 
·  Factors 
·  Cards related to selected Reference or Factor 

 
 

Project & Outline Previewing 
Select "Preview" from the application's File menu to preview the project or the project outline prior 
to printing or exporting. For convenience press the "Options" button from the Preview dialog to 
launch the application's print and export options to try different formats or to experiment with 
including or excluding different project elements. 
 
 

Exporting & Printing Options 
Writers can explore several options for exporting and printing projects by selecting the 
"Preferences" from the application's File menu in the Windows version and the Application menu 
on Macs. Click the "Print & Export" tab to reveal options covering whether to include deck and 
card content, fiction or non-fiction specific content, and finally whether to output the collection of 
flagged cards and trashed elements. 
 
For decks and cards, writers can specify whether to output titles, the element text or description, 
outline prefix, scene times, tension, flag notes, categorization, related references, and whether to 
insert page breaks between elements. The output font can also be selected.  
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Application Preferences 
 
SuperNotecard's application preferences introduce a variety of ways to customize the 
application's behavior for all projects every time the product launches. 
 

General 
Visit the General tab to choose Start Up, Spelling, and Save options. 
 

 
 
 

Display 
For display related options, SuperNotecard lets users choose to work with the Project Explorer in 
a separate window and move the Project Navigation Bar to the left or right on the screen. To 
conserve screen real estate, the Project Navigation Bar can also be hidden entirely. 
 
Choose to show the card sequence number in the project explorer and finally an option to set the 
background color of the application. 
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Text 
The Text tab adds controls to set the font size and face for four areas in the application. Select 
"Text Editing Font" (  ) to specify the font face and size to use when editing project content, 
particularly in cards. Select "Deck Display Font"  (  ) to specify the font face and size to use 
when working with elements within the Deck Display. Select "Project Explorer Font" (  ) to 
specify the font size and face to use for the Project Explorer. Or, select "Print & Export to RTF 
Font" to specify size and face for exporting and printing projects. 
 
Also choose text color options and control whether to automatically highlight related Factors and 
References in cards. 
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Print & Export 
The last tab displays a wide range of options to control how every project will print and translate 
into exported RTF files. The element options dictate what content to output and in what manner. 
The latest release introduces an option to output References in a format defined by the Modern 
Language Association (MLA). Visit http://www.mla.org for more information on the characteristics 
of the MLA format. 
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Tools 
 

Project Find & Replace 
The Project Find & Replace tool enables writers to search for specific text in the project and 
replace it with different text. To begin enter the text you wish to find. Next specify whether you 
require case matching and enter the new text. Press the Find button to begin the search for 
replacement candidates. 
 
The project elements that include the search text will appear in the list to the left beneath the 
fields. Select an entry to view the contents of the element. Press "Snow Next" to jump to the 
exact references in the text. Press "Show Details" to view its details in the main application 
window. 
 
Once a row is selected and a specific instance highlighted, press the button entitled "Replace" to 
perform the specific text replacement. To replace every reference for the displayed element, 
press the button labeled, "Replace All." 
 
Note: because text replacements cannot be undone, it is a great idea to save a back-up of your 
project before conducting a sweeping Project Find & Replace. 
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Project Colors 
The Project Colors tool makes it easy to peruse the colors and the elements that relate to them in 
your project. It is also equipped to help create sets of favorite colors to share between projects. 
Use the Import and Export controls to share these favorites with another installation of the 
program. 
 
Select any color along the left side to see the color's red, green and blue numeric values and a 
listing of the cards, decks, references and categories that use the color. If a card relates to a 
category that uses the selected color, then it will appear in the list. Select any of the listed 
elements to load that item in the main window. 
 
Select the star button to add a color to the favorites section. In the favorites section, use the 
pencil to edit, the arrows to re-organize and the trash to delete the selected color. Press the plus 
button to add a new color to your favorites. 
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Project Sorter 
To temporarily sort the project decks and cards by last changed date or title, select Project Sorter 
from the Tools menu. In the dialog that follows, choose what to sort, how (either date or title) to 
sort it, and finally select the sort order. Press "Sort" to view the results in the table below. Double- 
click any entry in the table to view its details in the main application window. 
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Project Statistics 
Select Project Statistics under the Tools menu to view a report showing the number of words in 
the project grouped by Card and Deck. The report also shows the total number of Cards, Decks, 
fiction Factors and Plots and non-fiction References and Categories. 
 

 

����	����
�����	�  
 
 



SuperNotecard Help Documentation 52 

AppleScript Manager 
For Mac OS X users, SuperNotecard introduces an AppleScript tool that enables users to create 
and execute AppleScripts that perform common tasks like launching another reference database 
such as BookEnds or conducting a Google search. SuperNotecard's AppleScripts are executed 
by either selecting them from the Tools menu or by pressing the appropriate keyboard shortcut. 
 
To create a new script, press the "Add" button. Select an existing script from the list and press the 
"Edit" button to modify the script. Press "Test" to execute the selected script and press "Delete" to 
eliminate the selected script. 
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SuperNotecard's AppleScript editor includes areas to enter the script name, designate a function 
key for the keyboard shortcut, and finally to write the script code. For tips and advice on writing 
scripts please visit Apple's AppleScript resource page. 
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Tips 
�

Starting a New Project 
·  Select "New Project" under the File menu. 
·  In the window that follows choose either a fiction, non-fiction or screenplay. 
·  Once the default project for the specified type opens, enter the title and description and 

select "Save Project" (Ctrl-S) under the File menu to save it on your computer.  
 
 

Saving a Backup 
·  With an open project, select "Save Backup" under the File menu. 
·  In the window that follows specify a new, backup name for the project. 
·  Resume working with project using the original file name.  

 
 

Defining Decks in a New Project 
·  If starting a new project, double-click one of a few pre-made decks to display its details. 
·  Revise the title to properly identify the deck 
·  Revise the description to summarize its contents  

 
 

Adding a new Deck 
·  Select "New Deck" under the Edit menu or press the new deck button from the toolbar 

above the desk display. The keyboard shortcut is Ctrl+M (Win) or Cmd+M (Mac). 
·  Revise the title to properly identify the deck 
·  Revise the description to summarize its contents  

 
 

Adding a New Card 
·  Select "New Card" under the Edit menu or press the new card button from the toolbar. 

The keyboard shortcut to add a new card is Ctrl+N (Win) or Cmd+N (Mac). 
·  Revise the title to properly identify the card. From the deck display card titles can be 

quickly changed by selecting the new card and pressing any key. After the editing box 
appears, type the desired title and press the "Enter" key to save the change. Press the 
"esc" key to cancel the change. 
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Common Keyboard Shortcuts 
 
 

Mac OS X Keyboard Shortcuts 
 
New Project Cmd+Shift+N 
Open Project Cmd+O 
Close Project Cmd+W 
Save Project Cmd+S 
Print Project Cmd+P 
Preferences Cmd+, 
Quit Cmd+Q 
  
Editing  
Undo Text Change Cmd+Z 
Redo Text Change Cmd+Shift+Z 
Cut  Cmd+X 
Copy Cmd+C 
Paste Cmd+V 
Highlight Text Cmd+J 
Bold Text Cmd+B 
Italicize Text Cmd+I 
  
Moving  
Move Element(s) Forward Cmd+Shift+] 
Move Element(s) Backward Cmd+Shift+[ 
Move Element(s) Up Cmd+Shift+Minus ('-') 
Move Element(s) Into New Deck Cmd+Shift+Equals ('=') 
  
Viewing  
View Project Explorer Cmd+E 
View Project Home Cmd+Shift+H 
View Previous Element (in sequence) Cmd+[ 
View Next Element (in sequence)  Cmd+] 
View Parent Deck Cmd+Enter 
View Project Find & Replace Cmd+F 
Expand tier one in the Project Explorer Cmd+1 
Expand tier two in the Project Explorer Cmd+2 
Collapse tier one in the Project Explorer Cmd+Shift+1 
Collapse tier two in the Project Explorer Cmd+Shift+2 
Show/Hide Project Navigation Bar Cmd+T 
  
Deck Display  
Select All Cmd+A 
Move Element(s) to Trash Cmd+Backspace 
Insert New Card Cmd+N 
Insert New Deck Cmd+M 
Flatten (Show/Hide the Project Hierarchy) Cmd+/ 
Increase Element Size Cmd+Plus('+') 
Decrease Element Size Cmd+Minus ('-') 
Show/Hide Key Cmd+K 
Flag Selected Element Cmd+Shift+F 
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Card Display  
Find References in Card Text Cmd+K 
Clear Found References in Card Text Cmd+Shift+K 
Show/Hide Factors/References in Card Cmd+R 
Quick Insert Reference or Factor Cmd+L 
Flag Cmd+Shift+F 
Keyword Search F8 
  
 
 
 

Windows Keyboard Shortcuts 
 
New Project Ctrl+Shift+N 
Open Project Ctrl+O 
Close Project Ctrl+W 
Save Project Ctrl+S 
Print Project Ctrl+P 
Preferences Ctrl+, 
Quit Ctrl+Q 
  
Editing  
Undo Text Change Ctrl+Z 
Redo Text Change Ctrl+Shift+Z 
Cut  Ctrl+X 
Copy Ctrl+C 
Paste Ctrl+V 
Highlight Text Ctrl+J 
Bold Text Ctrl+B 
Italicize Text Ctrl+I 
  
Moving  
Move Element(s) Forward Ctrl+Shift+] 
Move Element(s) Backward Ctrl+Shift+[ 
Move Element(s) Up Ctrl+Shift+Minus ('-') 
Move Element(s) Into New Deck Ctrl+Shift+Equals ('=') 
  
Viewing  
View Project Explorer Ctrl+E 
View Project Home Ctrl+Shift+H 
View Previous Element (in sequence) Ctrl+[ 
View Next Element (in sequence)  Ctrl+] 
View Parent Deck Ctrl+Enter 
View Project Find & Replace Ctrl+F 
Expand tier one in the Project Explorer Ctrl+1 
Expand tier two in the Project Explorer Ctrl+2 
Collapse tier one in the Project Explorer Ctrl+Shift+1 
Collapse tier two in the Project Explorer Ctrl+Shift+2 
Show/Hide Project Navigation Bar Ctrl+T 
  
Deck Display  
Select All Ctrl+A 
Move Element(s) to Trash Ctrl+Backspace 
Insert New Card Ctrl+N 
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Insert New Deck Ctrl+M 
Flatten (Show/Hide the Project Hierarchy) Ctrl+/ 
Increase Element Size Ctrl+Plus('+') 
Decrease Element Size Ctrl+Minus ('-') 
Show/Hide Key Ctrl+K 
Flag Selected Element Ctrl+Shift+F 
  
Card Display  
Find References in Card Text Ctrl+K 
Clear Found References in Card Text Ctrl+Shift+K 
Show/Hide Factors/References in Card Ctrl+R 
Quick Insert Reference or Factor Ctrl+L 
Flag Ctrl+Shift+F 
Keyword Search F8 
 
 


